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System Galaxy Procedure  

TKE Agile Elevator Solution for System Galaxy 
 Configuring System Galaxy to integrate with TKE Agile Elevator System. 

( TKE Legacy Solution for in-cab readers is not supported by the TKE Agile Elevator System. ) 
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Published FEB 2024   

 
 
 

  



Page 2 of 25 

Contents 
Introduction to System Galaxy TKE Elevator Solution ................................................................................................................. 3 

System Overview of the TKE Elevator Integration ................................................................................................................... 4 

Types of ‘Available Floors’ in the Elevator System ............................................................................................................... 4 

OPERATIONAL RULES ............................................................................................................................................................... 5 

GALAXY HARDWARE CONFIGURATION ........................................................................................................................................ 6 

HARDWARE CAPABILITY ....................................................................................................................................................... 6 

EQUIPMENT NEEDED ........................................................................................................................................................... 6 

Programming a 635-CPU Using the RS-232 Serial Cable ......................................................................................................... 7 

Configure the Galaxy TKE Board Settings .............................................................................................................................. 10 

Upload the ‘Kiosk List’ (TKE Device List) ................................................................................................................................ 11 

Programming System Galaxy Software ...................................................................................................................................... 13 

PROGRAMMING PARAMETERS .......................................................................................................................................... 13 

Adding a TKE Control Panel to System Galaxy ....................................................................................................................... 14 

Creating a Custom Free-Floor Schedule for Elevators ........................................................................................................... 16 

Creating a Custom Cardholder Schedule (for a Card Access Group) ..................................................................................... 17 

Creating ‘Elevator Access Groups’ for Landings (including Free Floors) ................................................................................ 18 

Creating Cardholder Access Groups for card access .............................................................................................................. 20 

Configuring Elevator Floors in System Galaxy ........................................................................................................................ 21 

Assigning ‘Special Elevator Options’ to Cardholder Credentials ............................................................................................ 23 

SUPPORTED ELEVATOR FEATURES ..................................................................................................................................... 23 

CONFIGURING ELEVATOR FEATURES ................................................................................................................................. 24 

Appendix ................................................................................................................................................................................ 25 

Creating a ‘Kiosk List’ Text File (aka TKE Device List) ......................................................................................................... 25 

 

 

 

 

  



Page 3 of 25 

Introduction to System Galaxy TKE Elevator Solution 

This guide covers how to configure System Galaxy hardware and software to integrate with TKE Agile Elevator System.  

This guide covers the following …  

• System Overview, Key Terminology, Operational Rules. 
• Capabilities and Requirements for TKE Elevator System.  
• Hardware Programming of the Galaxy TKE Controller (CPU and TKE Board) 
• Sending the Kiosk List to the TKE Board 
• Software Programming of the TKE Controller   
• Creating Schedules and Access Groups for the Elevator System (Free Floors)  
• Creating Schedules and Access Groups for the Cardholder Access (Secure Floors)  
• Configuring TKE Elevator Landings / Doors / Free Floor Access Rules.  
• Assigning Special Elevator Options to Cardholder Access Credentials 
• Creating the Kiosk List text file (Appendix) 

 

TERMS USED IN THIS GUIDE 

• DESTINATION-BASED ELEVATOR SYSTEM = a destination-based elevator system, determines which elevator cab (car) a 
passenger should take to reach a requested floor (i.e., their destination).  

• AVAILABLE FLOORS = the available floors are the list of floors a passenger is allowed to access. The available floors 
include free floors and secure floors.  The available floors are contingent on the time schedules and access rules.   

• ELEVATOR DOORS (FRONT & REAR) = some elevator cars have only a front door. Some elevator cars have both front and 
rear doors. The SG Operator will define which floors have front and rear doors in the TKE Elevator Programming screen.  

• EMBEDDED READER = an access reader installed in a Kiosk(s), which is located on a landing outside of the elevator cars. 
Note that ‘In-cab Readers’ are not used in the Agile Elevator System.  

• FREE FLOOR = a free floor allows free access during a specific time period and is contingent on which landing the request 
originates from. A floor can be free from one landing, yet not free from a different landing. The “free-floor access rules” 
are assigned to the ‘originating floors’ in the System Galaxy TKE Elevator Programming screen. 

• SECURE FLOOR = a secure floor requires an access card. Access is granted based on the schedule and floors assigned to 
the card, regardless of which floor the request originates from. Card access is assigned in Cardholder Enrollment screen.  

• KIOSK = a pedestal-mounted or wall-mounted terminal that has a user display that tells a passenger which floors are 
available and which elevator car to use in a destination-based elevator system. 

• LANDING = a landing is a floor or level in a building where passengers can enter and exit an elevator car.  

• TKE BOARD = is the Galaxy 635-TKE Elevator Control Board that is installed on the I2C bus and connects / communicates 
with the TKE Elevator System. The TKE Board broadcasts the List of Floors to the elevator system (locked and unlocked 
floor list) when the system comes online and when a floor request is made.  

• TKE CONTROLLER (PANEL) = Galaxy’s 635 Controller CPU with a TKE Board installed on the I2C Bus.  

• TKE Device List (Security Table) = the Device List is a text file containing the TKE Device IDs of all the elevators and 
kiosks that are in the elevator system. This list must be uploaded to the Galaxy TKE Board.  

• TKE ELEVATOR SYSTEM = collectively any or all of the components that belong to the TKE destination-based system.  

  



Page 4 of 25 

System Overview of the TKE Elevator Integration 
The TKE Agile Elevator System communicates directly with the Galaxy TKE Control Panel on the TKE network. The 
TKE Elevator System will send an access card data to the Galaxy TKE Panel and the panel will return a ‘list of 
available floors’ based on the access privileges of the card being presented.  Galaxy’s TKE Panel also periodically 
sends a ‘list of free floors’ to the Elevator System based on System Galaxy’s Floor programming. Updates to the 
free floor programming can take up to 15 minutes to take effect.  

Types of ‘Available Floors’ in the Elevator System 
In the TKE Elevator System there are essentially two types of available floors: free floors and secure floors … 

SECURE FLOORS / CARD ACCESS 
The secure floors are managed through card access. The card access can include access to both elevator floors and standard 
non-elevator doors. The passenger’s card access to a secure floor is based on the assigned schedule at the time the card is 
presented at a Kiosk. Card access is never contingent on which floor the card request originates from.  

FREE FLOORS / FREE ACCESS 
The “free floors” are managed through the Galaxy elevator configuration. The free-floor configuration is sent to the TKE 
Elevator System from the Galaxy TKE Control Panel when the panel comes online.  Access to a free-floor is based on the 
assigned schedule at the time the request is made and is always contingent on which floor the floor request originates from.  

Diagram 1 – System Integration depicting Floors programming/behavior and network communication.  
In the diagram below, ‘Floor #2 Lobby’ is designated as free floor in the system programming. The ‘Free 2 Lobby’ access group 
is assigned to the originating floors (1, 3, & 4), but not to the destination floor (2).  In this scenario, if the Floor#2 request 
originates from floors 1, 3, or 4, then the passenger will be transported to floor 2, provided the schedule is active (green).  
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OPERATIONAL RULES 

GALAXY HARDWARE 

1. The Galaxy TKE Control Panel connects directly to the TKE network.  
2. Only 1 Galaxy TKE Control Panel per TKE Agile Elevator System. 
3. A Galaxy TKE Control Panel supports 1 635-CPU & 1 Galaxy 635-TKE Board.  
4. A TKE Representative will provide the IP Address, Network Mask, and Gateway Address for the Galaxy TKE 

Board configuration. 
5. TKE must provide a ‘Kiosk/Device List’ for all Elevators and Kiosks in the TKE System – refer to the “TKE 

Security Table” (xls file). The ‘Kiosk/Device List’ must be converted to text file format before loading it into 
the Galaxy TKE Panel.  

LANDINGS (FLOORS) 

1. Galaxy TKE Panel supports up to 128 Front Landings and 128 Rear Landings. 
2. Any Landing can be assigned a Free Access schedule via System Galaxy programming.  

ELEVATOR CARS 

1. Galaxy TKE Panel supports up to 15 Elevator cars per ‘TKE Elevator Group’. The TKE Elevator Group is not 
visible to the System Galaxy software or SG System Operator.   

2. Elevators can have front and rear doors.  

KIOSKS READERS  

1. A floor (landing) can have up to 16 Front Kiosks and up to 16 Rear Kiosks. 
2. All kiosks on the same landing will have the same free floors within the Elevator System. 

SYSTEM OPERATION PROCESS 

1. Approx. 60seconds after the Galaxy TKE Panel comes online, the panel will broadcast the free floors to the 
elevator system for all Kiosks on all landings.  

2. When changes are made to the Free Floor programming, the Galaxy TKE Panel can take up to 15 minutes 
to update the Elevator System with the new free floor schedules.  

3. Once the Cardholder & Elevator Floor programming and access programming is completed, the data must 
be loaded to the Galaxy TKE Panel, which stores the access cards & access rules for when the card is used. 

4. When an access card is presented at a kiosk, the TKE System sends the card data to the Galaxy TKE Panel 
for an access decision. The Panel will return a list of available floors that the cardholder has access to, 
based on the assigned access privileges and the schedule at the time the card is presented.   

5. Card Access to an elevator floor is based on the access rules assigned to the card. The elevator system will 
also allow the passenger to go to any free floors based on which floor the access request originated from.  

6. When a free floor request is made at a kiosk, the elevator system will allow the passenger to go to the 
requested free floor contingent on which floor the request is originated from and provided the assigned 
schedule is active at the time of the request.  

7. Free floors are contingent on which floor the request originates from. 
8. Secure floors are never contingent on which floor the request originates from. 
9. Support for ADA, VIP, Code Blue, and TKE Service     
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GALAXY HARDWARE CONFIGURATION 
This section covers programming the hardware (635-CPU and TKE Board) to connect and communicate with the 
TKE Elevator System. 

 

HARDWARE CAPABILITY 

The Galaxy TKE Controller supports 1 Elevator System per building – i.e. 1 Galaxy TKE Controller per Elevator 
System.  

• Up to 15 Elevator Cars per elevator group  

• Up to 128 Landings per elevator group  

• Up to 16 Front/16 Rear Kiosks per landing per elevator group  

• Up to 4 Elevator Groups per elevator system.   

• 1024 Kiosks per Elevator System. 

 
 

EQUIPMENT NEEDED 

To program the TKE Panel you need the following equipment.  

1. Computer or Laptop with a Serial Com port (USB Com Port) 

2. An RS-232 Programming Cable for USB to 9-pin Serial  

3. TeraTerm Setup as follows: 
o 57600 Baud 
o 8-bit Data 
o 1 Stop bit 
o No Parity 
o No Flow Control 

 
4. TKE Control Panel with the following … 

o a 635-CPU with correct Flash version: (v11.0.10 or higher) 

o a 635-TKE Board (comes flashed from factory) 

5. You must obtain the LAN network addressing for the Galaxy CPU Board to connect on the Corporate LAN 
(IP Address, Subnet Mask, Gateway address).  

6. TKE Representative will provide the TKE network addressing for the Galaxy TKE Board (IP Address, Subnet 
Mask, and Gateway Address). 

7. The TKE Kiosk List must be sent to the Galaxy TKE Board using TeraTerm in a text file format (.txt format). A 
TKE Representative must provide the Kiosk List (TKE Security Table) to the Galaxy installer in XCLS format. 
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Programming a 635-CPU Using the RS-232 Serial Cable 

1. Open TeraTerm app (TT) on the computer  

 

 

2. In the TeraTerm New Connection window, choose the Serial option. 

3. In the Port droplist, choose the correct ‘COM# from Serial Port’ for your Serial Cable. 

4. Click OK to save this selection.  

 

 

5. In TeraTerm, go to menu Setup > Serial Port, and set the following options … 

• 57600 Baud 
• 8-bit Data 
• 1 Stop bit 
• No Parity 
• No Flow Control 

 

 
 

6. Click OK to save setup.  
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7. Connect the Serial USB Cable from the computer USB COM Port to the 635-CPU Serial Port. 

8. At the blinking cursor: press <Enter> key (to see the “>” command-line prompt)  

9. At command-line: type the “config” and press <Enter> key (the Boards List is displayed) 

 

 

10. Type “0” (zero) and press <Enter> key (current CPU Settings display) 

11. At “Make changes? y/n” prompt: type “yes” and press <Enter> key (to begin programming) 
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12. The settings must be typed correctly, then press the Enter key to advance to the next field.  
• IP Address   (IP Address of this panel; keep factory default address if using DHCP) 
• Network Mask   (Network Mask) 
• Gateway Address (Gateway Address) 
• Cluster Group ID (0) (should be 0; do not change) 
• Cluster ID (numeric, must be valid within SG) 
• Panel Unit ID (numeric, must be unique within Cluster and valid in SG) 
• CPU Number (should be 1) 
• Event Server 1 Active (must be set to “y”) 
• IP Address (IP Address of the computer hosting the Event Service) 
• Remote Port (should be 3001) 
• Local Port  (should be 3001) 
• Event Server 2 thru 4 (should be “n”; press ENTER to skip) 

 
13. Type “yes” and press ENTER KEY to save the panel settings. 

RESULT: The New Configuration will display so you can review and verify your settings. 

 

14. Review the New Configuration and type “yes” to permanently save the CPU settings.   

15. Disconnect the Serial Programming Cable from the CPU Board.   

16. Land the CPU ethernet cable on the Galaxy or Corporate network. 

17. Cold Reset CPU by holding the reset button up to 30 sec.  

18. You will need to flash the CPU to v11.0.10 (or higher) using GCS Loader. 
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Configure the Galaxy TKE Board Settings 
You must configure the Galaxy TKE Board settings. TeraTerm will use the same Serial Comm Setup as the 635-CPU. 

• USB Serial Programming Cable 
• Use TeraTerm to program the Galaxy TKE Board  

( 57600 Baud, 8-bit Data, 1 Stop bit, No Parity, No Flow Control) 

 

1. Connect your USB Serial Programming Cable from the PC to the TKE board. 

2. To begin: press <Enter> key (to see the “>” command-line prompt) 
3. Type “config” at the command prompt to begin configuring the board.  
4. At the prompt, type “yes” to make changes. 

5. Type the Static IP Address (from TKE) and press <ENTER> key to move to the next field. 

6. Type the Network Mask (from TKE) and press <ENTER> key to move to the next field. 

7. Type the Gateway Address. (from TKE) and press <ENTER> key to move to the next field. 

8. Set Ethernet Mode to “0” (auto negotiate). 
9. Set the Board ID to “1” on the I2C Bus. 
10. Set the Kiosk RAM to “0” 
11. Set the Flash to RAM to “1” (allows Kiosk List to burn to permanent memory) 
12. Set the Auto to “1” 

 
13. Type “yes” to save the TKE Board settings.  

RESULT: The ‘New Configuration’ will be displayed for your review.  

• Notice: You can reissue the “config” command to make more changes, and use the ENTER key to skip any 
fields you do not want to change.  

• When you are satisfied that your board settings are correct, proceed to uploading the Kiosk List text file 
using TeraTerm.   
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Upload the ‘Kiosk List’ (TKE Device List) 
You must upload the TKE Device List into the Galaxy TKE Board from a plain text file using TeraTerm.   

• TKE administrator will provide the TKE Device List, which is in their TKE Security Table (.xls format). This is a 
list of all TKE Devices on every landing (floor) in the Elevator System. The list includes all the Elevator 
Device IDs and all the Kiosk Device IDs.  

• The TKE Device List (Kiosk List), it must be converted into a plain text file with one Device ID per line.  
• For instructions on how to make the text file, see Appendix : Create the TKE Device List.   

 
1. While TeraTerm is still connected to the TKE Board, type “tke recv” and press <ENTER> key. 

 
 

2. On the TeraTerm menu, select File > Send file …  

 
 

3. Navigate to the Kiosk List in the Send File window and select (highlight) the Kiosk List filename and click 
OPEN button. 
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4. The device list will be sent to the TKE Board.  
RESULT: TeraTerm will display the total number records imported, records rejected, including the number 
of Kiosks imported and the number of Elevators imported. 

 

5. Type “tke burn” and press <ENTER> key. 

6. Reset the TKE Board by pressing the reset switch on the physical board. 

7. Type “tke flash” and press <ENTER> key to see the List of Kiosks that are saved in the board. 

 

NOTICE: If you need to add or delete any item (kiosk or elevator), simply make the needed changes to the 
text file and re-send the whole list to the Galaxy TKE Board using these instructions. Remember that you 
must issue the ‘tke burn’ command to reflash the list into permanent memory. And if these changes also 
affect the software programming, you must add or remove the floor landing(s) from the software to match 
the system changes.  

 

TIP: If needed, you can use the “tke flash” command to display the existing list so you can select and copy 
the whole list from the TeraTerm screen and then paste it into a text file, where you can edit it and make 
any corrections, additions, or deletions as desired. Remember that the list must be in plain text format 
(.txt file) and must have the word “End” on the last line.  See Appendix : Create the TKE Device List for 
more details. 
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Programming System Galaxy Software  
This section covers adding the TKE elevator programming to the System Galaxy software. 

The following sections are covered …  

• TKE Control Panel and Board to a Cluster  
• Defining the number of Elevator Landings (Floors) and front/rear doors 
• Creating Schedules - for Elevator Floors and Cardholder Access 
• Creating Access Groups - for Elevator Free-Floors and Cardholder Access to secure floors.  
• Assigning Access Groups to Elevator Floor programming and Cardholder programming. 

 
PROGRAMMING PARAMETERS 

System Galaxy can support multiple Elevator Systems within the SG Access Control System. A practical example of 
this would be a campus situation where there are multiple buildings with an Elevator System in each building.  

 

The following stipulations apply to the system programming … 

• Only 1 TKE Panel per Elevator System. 

• You can add more than 1 TKE Panel to a Cluster if you have more than 1 Elevator System. 

• In System Galaxy, a Cluster can contain both normal Access Control Panels and TKE Panels.  

• When you create Free Floor Access Groups (for the TKE Elevator Programming), you will not add any 
standard doors/readers to the “Authorized List”. The ‘Authorized List’ must be empty for TKE groups. 

• When you create Card Access Groups (for the cardholders), you can add both standard readers/doors to 
the “Authorized List” and also add elevator floors to grant access to secure floors.  
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Adding a TKE Control Panel to System Galaxy 
This topic covers how to add a Galaxy TKE Elevator Control Panel to the System Galaxy software. Adding a TKE 
Control Panel is like adding any other Access Control Panel, except the TKE Control Panel communicates with the 
TKE Elevator System.  

REQUIREMENTS & STIPULATIONS 

• You can have only 1 TKE Controller per Elevator System.  

• A TKE Controller can only have 1 TKE Board and no other boards on the I2C Data Bus. 

• A TKE Board supports up to 128 floors Front and Rear.   

• When you add a TKE Controller in System Galaxy, you must designate how many floors are supported by the panel 
and whether it has front and rear doors. This information will come from TKE Operator.  

 

1. Open the Controller Programming screen: Configure > Hardware > 635 Clusters  

2. Select the desired Cluster Name that the controller will belong in. 

3. Click the Add New button to begin adding the TKE Control Panel to the system. 

RESULT: When you click the [Add New] button, the software usually auto-adds a daughter board.  
You must delete the daughter board since the TKE panel cannot have any daughter boards on the I2C Bus.     

a. If a daughter board was added, select (highlight) the daughter board 

b. click [Delete Board] button to remove the daughter board from the TKE Controller.  

4. Enter a descriptive name for the TKE Controller if desired.  

5. Click (select) the 635 CPU tab and set the CPU-Model droplist to “635”. 

6. Click (select) the Interface Boards tab and click [Add Board] button.  

RESULT: The Interface Board window will open.  

a. Select the “TKE Elevator Interface (TKI)” from the Board Type droplist. 

b. Click OK to add this board to the controller. 
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7. The TKE Elevator Interface board will be added to the controller Boards tab (as seen below). 

8. Click APPLY button to save the TKE Controller in the system. 

RESULT: The TKE Elevator Settings window will open. These settings will come from the TKE Operator. 

a. Enter the number of floors (2 - 128) into the TKE Elevator Settings window.  
RESULT: This choice will determine the default number of floors (landings) that are displayed in the 
TKE Elevator Programming screen. 

b. Choose whether elevators have Only Front Doors or Front & Rear Doors.   
RESULT: This choice will determine whether the TKE Elevator Programming screen will display front 
only or front and rear landings.  

c. Click OK to add these elevator floors and doors to the system programming.  

 
9. At this point, the Hardware Tree will display your TKE Controller. You may need to refresh/reopen the 

Hardware Tree from the menu View > Hardware Tree.  

10. Also at this point. the TKE Elevator Programming screen will be populated with the number of front and rear 
floors (landings) that you added to the TKE Board. 

 

WHAT’S NEXT 

Schedules and Access Groups must be created in System Galaxy before you can complete the TKE Elevator 
Floor Programming and before you can assign Cardholders Elevator Access.   

The following sections cover creating schedules and access … 

• Create Custom Schedule for Free-Floors  
• Create Cardholder Elevator Schedule  
• Create Elevator Access Group for Free-Floors 
• Create an Elevator Access Group for Cardholders 
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Creating a Custom Free-Floor Schedule for Elevators 
The purpose of a Free Floor Schedule, is to control when a free-floor is available for access.  

• A custom schedule will grant access (green) only for specific times and days. This can be affected by holidays.  
• You can make a custom “24/7 schedule”, that grants free access all times/all days, that is affected by holidays. 
• Optionally, you can assign the system’s built-in “Always” schedule to a floor in the Access Group screen, but 

this is not affected by holidays. The built-in “Always” schedule is not affected by holidays/  

HOW THE SCHEDULE TIME-SEGMENTS WORK:  
To change the state of the time schedule (lock & unlock) you will click time-capsules (segments) of each day.  

> Left-click = Green (unlock): this is the time you want the free floor to be available/open. 
> Right-click = Red (lock): this is the time you want the free floor to be unavailable/closed. 

In the example below, you are shown how to make a 24/7 Unlock Schedule that can be affected by holidays/special days. You 
can then apply this schedule to a ‘Free Floor Access Group’, and then assign the access group to the desired floors in the TKE 
Elevator Programming screen.   

 
1. Open Schedules: Configure > Schedules 

2. Click Add New button. 

3. On the desired first week-day (row) of your schedule (i.e., Sunday or Monday, etc.), click on the first time 
capsule when you want the unlock schedule to begin (ex: 8am).  

4. Click-n-drag the mouse across the capsules for as long as you want the schedule to stay unlocked.  
NOTE: Green is unlock. Red is lock.    
HINT: You can click-n-drag your mouse to spread the color (green or red) across the time-capsules.  

5. Click the Copy button to clone the schedule to other days.  

6. In the Copy Time Data window, select the day you want to copy from in the droplist. 

7. Click to place a checkmark in every day that you want to Copy to in the list of days. 

8. Click OK to copy the time to all the selected days. 

9. If you want this schedule to be affected by holidays, check that option and set up the unlock times as desired.  

10. Click APPLY to save settings when you are satisfied with the schedule programming.  
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Creating a Custom Cardholder Schedule (for a Card Access Group) 

To create a Schedule for a cardholder, you must decide when you want the cardholder to have access.  

• Green will grant the cardholder access.  
• Red will deny access.  

In this example, you are shown how to make an 8-5 Unlock Schedule that can be affected by holidays/special days.  
You can apply the schedule to a Card Access Group. Then you can assign the card access group to an access card in the 
Cardholder Enrollment screen.   

 
1. Open Schedules: Configure > Schedules 

2. Click Add New button. 

3. On the desired first week-day (row) of your schedule (i.e., Sunday or Monday, etc.), click on the first time 
capsule when you want the unlock schedule to begin (ex: 8am).  

4. Click-n-drag the mouse across the capsules for as long as you want the schedule to stay unlocked.  
NOTE: Left-click = Green (unlock). Right-click - Red (lock).    

5. Click the Copy button to clone the schedule to other days.  

6. In the Copy Time Data window, select the day you want to copy from in the droplist. 

7. Click to place a checkmark in every day that you want to Copy to in the list of days. 

8. Click OK to copy the time to all the selected days. 

9. If you want the schedule to be affected by holidays, check that option and set up the unlock times as desired.  

10. Click APPLY to save settings when you are satisfied with you schedule programming.  
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Creating ‘Elevator Access Groups’ for Landings (including Free Floors) 

The purpose of an Elevator Access Group (Free Floor Access Group), is to control when the floor(s) (landings) are 
unlocked (i.e., available for access), as well as locked (not available). This is done by linking an elevator schedule to 
one or more elevator floors. You can Elevator Access Group will An Elevator Floor can be free all the time or only 
during certain periods.  

• You must have created the Elevator Schedule and assigned any effective holiday as needed.  
• You can assign multiple floors to a Free-Floor Access Group. All floors in the same access group will have 

the same schedule and same holidays if applicable.  
• If you need a separate schedule/holiday for separate floors (landings), then you need to create a separate 

Free-Floor Access Group and apply the desired schedule to those chosen floors.  

 

1. Open the Access Group screen. 

2. Click Add New button to start a new access group. 

3. Select the Cluster that the TKE Controller is in. 

4. Enter a descriptive Name - that you can tell it belongs to the elevators and what the group does. 
Example: Free floor #3, Or Free floor 3  and 4; to describe which levels this access group grants access to.  

5. On the Access Privileges tab, you will not move any readers to the Authorized list. … 
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6. Select the TKE Elevator Floors tab (pictured below). 

7. Select the TKI Reader from the droplist.  

8. Select the desired TKE Schedule  this is where you assign the Free Floor Access Group you made in the 
prior step. 

In the example below, ‘Free Floor 24/7’ is the name of the custom schedule. Optionally you can choose 
“Always”.  

• Built-in schedules (Always) are never affected by a holiday or special day.  

• Custom schedules can be affected by holiday schedules. 

9. Select (highlight) the floor(s) you want to be free or available during that chosen schedule.  

10. Click Apply to save. 
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Creating Cardholder Access Groups for card access  

When you create access groups for the Cardholders’ access cards, you do not add the TKI Reader to the 
authorized list (right side). You can add normal doors to the access group along with the elevator floors that 
card/cardholder will have access to. The normal doors are in normal controllers that are in the same Cluster as the 
TKI Reader (TKE Panel).   

1. Open the Access Group screen. 
2. Click Add New button to start a new access group. 
3. Select the Cluster that the TKI Controller) is in. 
4. Enter a descriptive Name (that describes what the access group does. 

Example: “Week-days + Floor 3 – 4”.  
5. On the Access Privileges tab, you can add access to normal doors for the Cardholder. 

a. You can move normal doors from other non-elevator panels to the authorized column by 
highlighting the door and clicking the Right-Arrow or just double-click on the door/reader you 
want to move.  

b. Optionally, you can choose not to add any normal doors to the authorized column. 
 

 
 

6. Select the TKE Elevator Floors tab (pictured below). 
7. Select the TKI unit from the TKI droplist.  
8. Select the desired TKE Schedule  here is where you pick the access schedule you made (8-5 for example).  
9. Select (highlight) the floors you want the card to have access to. No matter which landing the cardholder is 

on, they will have access to the selected floors in this group. 
10. Click Apply to save. 
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Configuring Elevator Floors in System Galaxy  

This TKE Elevator Programming screen allows you to configure the individual properties of each Floor/Landing.  

PREREQUISITES 
• You must have added your TKE Controller and TKE Board in the Controller Programming screen.  
• The number of Landings and front and rear doors is chosen when the TKE Board is added.  
• You must have created the Free-Floor Groups (i.e., elevator access groups) you need. 

You can edit the following properties on each Floor/Landing … 
• edit Floor Names for front and rear landings (floor name can be unique for front vs. rear landing) 
• toggle Front & Rear Doors checkboxes (in use yes or no) 
• assign up to 4 ‘Free-Floor Groups’ (Elevator Access Groups) to each floor/landing.  

Free-Floor Access Rules  
Note that the same Free Floor Groups will apply to all kiosks on both front and rear landings  

 

1. Open the TKE Configuration screen from Configure > Hardware > TKE Elevator Configuration 

2. Select the Cluster where the TKE Elevator Panel belongs. 

3. Select the TKI Elevator System you want to program. (The image below shows the first TKE System being 
programmed.) 

4. By default, the number of floors were set when you added the TKE Elevator Board in the Controller 
Programming screen.  

NOTE: You can add or delete floors from this screen as needed.   
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5. Double-click on an existing Floor/Landing to open the Floor Properties window (see below).  

a. Check or uncheck the “In Use” checkboxes for the rear door, as needed. 

b. Edit the Description of the Front and Rear Landings (floors), as desired. 

c. Select a Free Floor Group(s) for this floor as needed. 

NOTE: This is where you select the Elevator Access Group you created in an earlier step.  If you want 
a floor to be free from this floor, then choose the appropriate Free Floor Group that meets your 
requirements.  

You must have already created the Free Floor Group to be able to choose it here.  

The floors assigned to the Access Group you choose will be free from this Landing during the 
active periods of the schedule.   

d. For example: if Floor 2 is the Lobby and you need it to be free from all other floors, you will add the 
Free Floor Lobby access group to all other floors but not to the Lobby itself.   

e. You can add up to 4 Free Floor access groups, but keep in mind if any Access Group is active or is 
unlocked, then the elevator will be unlocked/available. 

 

 

6. Click OK to close the Floor Properties. Repeat step 5 for all floors.  

7. Click APPLY when you are finished.  
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Assigning ‘Special Elevator Options’ to Cardholder Credentials 
The SG Operator can assign Special Elevator Options (checkboxes) to a Cardholder’s access credentials. By this method, 
Galaxy can control which elevator option(s) are applied to the cardholder’s credentials.  

The Special Elevator Options are located in the Personal tab in the Cardholder Enrollment screen. This means that the options 
apply to all the access cards/credentials provided they are enrolled on that same Cardholder record.  

IMPORTANT: A person can have multiple access cards/credentials enrolled in System Galaxy.   
 

Example-1: Jack Green has 2 access credentials enrolled on the 
same cardholder record. Jack needs the ADA enabled. 

Example-2: Jane Smith has 2 access credentials enrolled on different 
cardholder records. Jane needs ADA enabled on both records. 

 

Conversely, if you needed an exclusive elevator credential (such 
as VIP Card, or Service Card, …), that doesn’t share its exclusive 

privilege with other cards, then you will want that card on a 
separate Cardholder record to prevent the exclusive privilege 

from being applied to multiple cards. 

 
 

SUPPORTED ELEVATOR FEATURES  
A basic description of the Galaxy-supported elevator options is provided below; however, consult with your TKE System 
Administrator for specific details of the feature functionality.  

• VIP: VIP-related privileges or priorities in the elevator system as defined by TKE System Administrator. 
• Code Blue: hospital emergency-related privileges in the elevator system. 
• TKE Service Option: for maintenance or service-related privileges in the elevator system. 
• ADA (Has Disability): this option supports privileges in the elevator system for passengers/cardholders with 

disabilities … such as extra time for doors to remain open when onboarding/offboarding, etc.  
• Vertigo: ( not currently supported by TKE Systems ) 

 

See steps to configure elevator features on NEXT page.   



Page 24 of 25 

 

CONFIGURING ELEVATOR FEATURES  
 

1. From the SG Menu: select Configure > Cardholders 
2. Click [Add New] if you are enrolling a new cardholder – or select an existing cardholder name and click Edit. 
3. Click the Personal tab, and locate the elevator options beneath the Main Photograph field. 
4. Enable (check) the specific elevator checkbox option(s) that apply to the cardholder – as needed.  

 Has Disability 
 VIP 
 TKE Code Blue 
 TKE Service Option 

5. Finish enrolling the cardholder name, personal info, card data, and access profile - as appropriate. 
6. Click the Apply button to save changes.   

 

 
System Galaxy Cardholder Enrollment screen | Personal tab. 
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Appendix 
This section contains information to assist you in configuring the Elevator System in System Galaxy. 

Creating a ‘Kiosk List’ Text File (aka TKE Device List) 

TKE Administrator will provide the Device List for the following …  
• up to 15 Kiosks front and rear (for up to 128 Landing (floors)) 

 
1. Open the NotePad app on your computer. 

2. Copy or type the list of devices - Elevators and Kiosks - formatted as shown in the example below: 

Numbering Convention: Group . Floor . Kiosk . F   front/rear door indicator (use “F” or “R”)  

The Example below has … 
• 2 Embedded Kiosks per Landing (kiosk-1 = F & R; kiosk-2 = F only) for 3-floors in TKE system. 
• 2 Elevator devices in the TKE system. 

1.1 .1 .F  
1 .1 .1 .R  
1 .1 .2 .F  
1 .2 .1 .F  
1 .2 .1 .R  
1 .2 .2 .F  
1 .3 .1 .F  
1 .3 .1 .R  
1 .3 .2 .F  
1 .255.1 .F  
1 .255.1 .R  
1 .255.2 .F  
End 

3. Type “End” on the last line of the file – with no spaces or additional blank lines after the “End”   

 
 

4. Select File > Save and save the filename as “Kiosk List” (must be .txt file format). 
5. Copy/move this text file to the computer that will be used to connect to the TKE Board.  
6. Go to the Upload Kiosk List topic in this guide to see how to send the file to the TKE Board.  
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